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1 Abstract 

The goal of this IQP was to develop and evaluate a new user interface for an 

online course management program called ReCourse. This was be carried out in 

three main phases — research, development, and testing. The first phase, 

research, is documented in section four of this document. The second phase 

uses the information gathered in phase one to create a user interface that is both 

pleasing and effective. The third phase utilizes standard user interface 

evaluation methodologies to compare the old interface with the new interface. 



2 Executive Summary 

Background: 

ReCourse is an online course management system developed at WPI 

though many projects. It has had several interfaces; however these 

interfaces were more of an afterthought. They were developed as small 

parts of large projects, and therefore little time was spent on their design. 

The toolbars were too large and looked unprofessional. This project 

focuses on designing a new interface for ReCourse that is functional and 

visually appealing. 

Methodology: 

After completing research into user-interface design, it was necessary to 

use the information gathered to design a pleasing user interface. The first 

interface designed consisted of five possible color schemes, each utilizing 

two different colors. This interface was then subjected to usability testing 

which showed that the five color schemes were not sufficient. Most web 

pages would not match these colors, giving the entire site an 

unprofessional appearance. The interface was then redesigned to allow 

the professor for a particular course to select two colors out of 40 available 

colors. This results in 1600 possible color schemes, which makes it easy 

to select pleasing colors for a course's web page. 
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Results: 

The final interface was subjected to the same usability test as the 

preliminary interface. Results show that the shortcomings of the 

preliminary interface (bad colors, unprofessional appearance) were fixed 

in the final interface. 

Conclusion: 

This project succeeded in developing a pleasing and usable interface for 

ReCourse. Both professors and students agree that the new interface is 

much better than the old one. This interface has not yet been used in a 

classroom environment, but will be used in the summer of 2000 and 

beyond. 
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3 Introduction 

ReCourse is an online course management program. The current interface is 

less than ideal. ReCourse is currently used by professors at WPI and will soon 

be used by a teacher at a Framingham high school. These professors and 

students will greatly benefit from an improved interface. Also, a better interface 

may encourage more professors to use ReCourse in their classes. Figures 1-3 

show the current toolbars. 
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Figure 2 
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Figure 3 

As can be seen, both the student and instructor toolbars occupy a significant 

amount of space. This is undesirable because it limits the amount of space that 

can be used for content. Also, the images used for the toolbar were downloaded 

from various sites on the Internet and do not have a consistent appearance. This 

leads to an unprofessional appearance. The focus of ReCourse is upon the 

content and the interface should reflect this. While the toolbar should be well 

designed, it should not be dominant. 

The interface developed as a result of this IQP should be both aesthetically 

pleasing and functional. It should be easy to locate elements on the toolbar and 

difficult to make errors. 
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4 Background 

4.1 Recourse 

ReCourse is an online system used for course management. It enables students 

and professors to track grades and assignments online and also facilitates 

communication between students and professors. It consists of two main 

interfaces, student and instructor. 

4.1.1 Student Interface 

The student interface contains: 

• Home page 
• Chat page 
• Search 
• Grades 
• Site Map 
• Bulletin Board 
• Online Quiz 
• Change Password 
• Class List 
• Help 

4.1.2 Instructor Interface 

The instructor interface contains: 

• Home Page 
• Links 
• Site Map 
• Chat 
• Search 
• Global Replace 
• Toolbars 
• Users 
• Grades 
• Bulletin Board 
• Quiz Generation 
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• Site Composer 
• Password 
• File Upload 
• Email Class 
• Group Mail 
• Help 
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4.2 Web Based User Interface Design 

There are many concepts that should be taken into consideration when designing 

a user interface for use on the Web. Colors, icons, menus, layouts, and 

consistency are all very important in creating an effective user interface. 

Unfortunately, all users have different opinions regarding what makes an 

interface appealing and it is impossible to create one that satisfies all users. 

Therefore, it is necessary to rely on the results of previous studies to determine 

what colors, fonts, etc. will be pleasing to the majority of users. 

4.2.1 Colors 

An appropriate choice of colors can give a professional look to an otherwise 

uninteresting interface. Color can draw attention to components, soothe the 

user, emphasize information, warn the user, or elicit emotional reactions. While 

color can have a positive effect on a user interface, care must be taken to avoid 

overusing or misusing color. Here are several guidelines for successful use of 

color in user interfaces tShneiderman, 1998]: 

• Use color conservatively 

• Limit the number of colors 

• Recognize the power of color as a coding technique 

• Ensure that color coding supports the task 

• Have color coding appear with minimal user effort 

• Place color coding under user control 

• Design for monochrome first 
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• Consider the needs of color-deficient users 

• Use color to help in formatting 

• Be consistent in color coding 

• Be alert to common expectations about color codes 

• Be alert to problems with color pairings 

• Use color changes to indicate status changes 

• Use color in graphic displays for greater information density 

While not all of these guidelines are relevant when designing a user interface for 

the web, several are crucial. The web is full of pages with atrocious color 

schemes. The designer must ensure that the colors are pleasing to users and 

imporove the web page. Also, the designer should never assume that the user 

has access to a color display and therefore must test the design in grayscale 

before deploying the interface. 

Another issue is that some colors are "browser-safe". There are 216 such colors. 

Use of other colors can result in unpredictable results in different browsers and 

on different platforms. 

4.2.2 Icons 

Text and icons are interchangeable in many circumstances. The particular 

application determines the more appropriate choice. When designing icons, 

several guidelines should be followed [Shneiderman, 1998]: 

• Represent the object or action in a familiar and recognizable manner. 

• Limit the number of different icons. 



• Make the icon stand out from its background. 

• Consider three-dimensional icons; they are eye catching, but also can be 

distracting. 

• Ensure that a single selected icon is clearly visible when surrounded by 

unselected icons. 

• Make each icon distinctive from every other icon. 

• Ensure the harmoniousness of each icon as a member of a family of 

icons. 

• Design the movement animation 

• Add detailed information, such as shading, thickness, color, or animation. 

• Explore the use of combinations of icons to create new objects or actions. 

These are the four levels of icon design [Marces, 1992]: 

• Lexical qualities — pixel shape, color, brightness, blinking 

• Syntactics — lines, patterns, modular parts, size, shape 

• Semantics — concrete versus abstract, part versus whole 

• Pragmatics — legible, utility, identifiable, memorable, pleasing 

Shneiderman suggests that a fifth level may be Dynamics: highlighting, dragging, 

combining, etc. 
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4.2.3 Menus 

Menus are important because they allow users to access information stored in 

the web site. There are many styles of menus that can be used and it is 

important to realize that the order of the items on a menu is not something to 

take lightly. 

Menu Structures 

• Single — A single menu 

• Linear — A linear sequence of menus 

• Tree — Each menu can lead to several other menus, but no two menus 

lead to the same menu. 

• Acyclic — Similar to the Tree structure but several menus can lead to the 

same menu. 

• Cyclic — Similar to the Acyclic structure but menus can lead back to menus 

at higher points in the tree. 

Menu Item Orders 

There are several common orderings for menu items — alphabetic, related items 

together, frequent items first, and important items first. 

According to a study detailed by Card [Card, 1982], users located commands 

more quickly when the menu items were presented alphabetically. Here are the 

results from the study: 
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Strategy Time per trial (seconds) 
Alphabetic 0.81 
Functional 1.28 
Random 3.23 

It is important to note that while alphabetic ordering generally results in users 

locating commands quickly, it may not always be the most appropriate choice. 

Random ordering is obviously not desirable but functional ordering does have an 

advantage in situations in which commands can be grouped easily and some 

commands are used much more frequently that others. 

4.2.4 Layouts 

Layouts for web pages differ from layouts in most applications. Users of web 

pages have come to expect a fairly standard interface with a menu or icons either 

on the top or left hand side, and the content opposing it. It is also common to 

place this menu in a separate frame from the content so that menu items do not 

change from page to page. 

4.2.5 Consistency 

An important concept in interface design is consistency. Pages in a web site 

should maintain a common appearance. This includes color schemes, icons, 

menus, and layouts. Terminology should also be consistent — similar actions 

should be named similarly, i.e. "Add Student" and "Add Grade", not "New 

Student", and "Add Grade". The user should not have to learn several different 

interfaces. 
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4.3 User Interface Evaluation 

4.3.1 Expert-Review Methods 

Expert-Review methods are commonly used in the professional world to evaluate 

user interfaces. There are several common methods used, although it is not 

necessary to utilize all the methods — just a few. 

Heuristic Evaluation 

Expert reviewers use a short list of design heuristics to evaluate an interface. 

One common list of heuristics is known as "The Eight Golden Rules" 

[Shneiderman, 1998]. 

The Eight Golden Rules  

1. Strive for consistency 

2. Enable frequent users to use shortcuts 

3. Offer informative feedback 

4. Design dialogs to yield closure 

5. Offer error prevention and simple error handling 

6. Permit easy reversal of actions 

7. Support internal locus of control 

8. Reduce short-term memory load 
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Guidelines Review 

Reviewers use a guidelines document to evaluate an interface. The guidelines 

document contains many more items that the list used in a heuristic evaluation, 

so it may take a long time to review the interface. 

Consistency Inspection 

Experts verify that an interface is consistent. Factors checked are color, 

terminology, layout, help, etc. 

Cognitive Walkthrough 

The reviewers simulate real users of the system and evaluate how well the 

interface facilitates the performance of common tasks. They also evaluate error 

recovery. 

Formal Usability Inspection 

This is similar to a court proceeding, with a moderator or judge. The experts 

present the merits and weaknesses of the interface and design team members 

may defend their decisions. 

1R 



4.3.2 Surveys 

Surveys have several benefits, mainly that they are inexpensive and can reach a 

large number of people. Questions in the survey should be focused in order to 

be able to draw conclusions from any data presented in the results. Online 

surveys cost even less than traditional surveys, but may be biased because 

many people do not have web access. 

4.3.3 Interviews and Focus Groups 

Interviews have an advantage over surveys because they are flexible. The 

interviewer can change the questions based upon the interviewees' responses. 

Also, more detailed responses are possible than with traditional, multiple-choice 

questions. Disadvantages include cost, time, and that only a few people can be 

interviewed. Focus Groups can investigate issues raised by interviews and 

determine if one user's opinion is widespread. 
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5 Methodology 

These are the steps that were taken in designing and evaluating a new user 

interface for ReCourse. 

5.1 Designing the Interface 

5.1.1 Colors 

Because there is no color scheme that everyone will like, and because 

instructors may wish to change the colors of the menu to match other pages 

in the site, the instructor's toolbar includes an option to change the color 

scheme. Initially, the instructor was allowed to select one of 5 predefined 

schemes. After a preliminary review it was decided to allow the instructor to 

choose a scheme that consists of 2 independent colors, each chosen from 40 

possible colors. The possible colors are web-safe and are shown below. 

1 n 11 n 111111111 n 
1111111.11111111111111S. 
n 111111111111111 n 
111100111111111IN 
EDOODLIMEE 

Note — colors appear slightly different on a computer screen than on a printed page. 

Darker colors have white text, while the light colors have black text. The 

default color scheme is black and white. More colors can be added easily; 

details on the procedure can be found in Appendix B. 
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5.1.2 Menus 

Tabbed menus were chosen rather than icons for several reasons. First, a 

tabbed menu occupies much less space than images. Second, it is difficult to 

represent the actions pictorially. Although testing has shown that it is fastest 

to locate menu items when they are ordered alphabetically, users of this 

system are fairly frequent users and will benefit from functional groupings, 

with most commonly used functions listed first. 

5.1.3 Layout 

The layout of this interface is simple — the menu is located at the top of the 

page and the content is shown below that. The menu item corresponding to 

the current page is indicated by using another color for the tab. When the 

user moves the mouse cursor over a tab, the tab color is changed through 

JavaScript code. 
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5.2 Implementing the Interface 

5.2.1 Image Creation 

The images were created using Paint Shop Pro 6.0. The tabs utilize 

layers, which allow the text to "float" above the background color. This 

allows the background color to be easily changed at any time without 

interfering with the text. 

5.2.2 JavaScript 

JavaScript code was written to change image colors when the mouse 

cursor moves over a tab. This is accomplished by using two images and 

switching them when a "mouseover" event occurs. The JavaScript code 

to accomplish this is shown below. 

<script language="JavaScript"> 

var g_Loaded = 0; 
var g_RoHovers = 0; 

if(((navigator.appName=="Netscape" && parselnt(navigator.appVersion)>=3) 
parseint(navigator.appVersion)>=4)) 

g_Rollovers=1; 

else 
{ 

g_Rollovers=0; 

function loadlmg() 

if(g_Rollovers) 

homeOn = new Image(); homeOn.src="student/images4c1/home_a.gif"; 
homeOff = new Image(); homeOff.src="student/images4c2/home.gir; 
homeBar = new image(); homeBar.src="student/images4c1/home_b.gif"; 
gradesOn = new Image(); gradesOn.src="student/images4c1/grades_a.gif"; 
gradesOff = new Image(); gradesOff.src="student/images/$c2/grades.gif'; 
gradesBar = new Image(); gradesBar.src="student/images/$c1/grades_b.gir; 
bboardOn = new Image(); bboardOn.src="student/images4c1/bboard_a.gif"; 
bboardOff = new Image(); bboardOff.src="student/images4c2/bboard.gif"; 
bboardBar = new Image(); bboardBar.src="student/images4c1/bboard_b.gif"; 
libOn = new Image(); libOn.src="student/images/$c1 /lib_a.gif"; 
libOff = new Image(); libOff.srt="student/images4c2ilib.gif"; 
libBar = new Image(); libBar.src="student/images4c1/lib_b.gif"; 
quizOn = new Image(); quizOn.srcestudentfimagesac1/quiz_a.gif"; 
quizOff = new image(); quizOff.src="student/images4c2/quiz.gif"; 
quizBar = new Image(); quizBar.src="student/images4c1/quiz_b.gif"; 
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chatOn = new Image(); chatOn.src="student/images/$clichata.gif ; 
chatOff = new Image(); chatOff.src="student/images4c2/chat.gif; 
chatBar = new Image(); chatBar.src="student/images/$c1 /chat_b.gif"; 
clistOn = new image(); ciistOn.src="studentfimagesacliciasslist a.gif"; 
clistOff = new Image(); clistOff.src="student/images4c2/classlist.gif; 
clistBar = new Image(); distBar.srcestudent/images4c1/classlist b.gif; 
passwdOn = new Image(); passwdOn.src="student/images4c1 /password_a.gif ; 
passwdOff = new Image(); passwdOff.src="student/images/$c2/password.gif; 
passwdBar = new Image(); passwdBar.src="student/images/$c1/password_b.gif ; 
searchOn = new Image(); searchOn.src="student/images4c1/search_a.gif"; 
searchOff = new Image(); searchOff.src="student/images4c2/search.gif"; 
searchBar = new Image(); searchBar.src="student/images/$cl/search_b.gif; 
sitemapOn = new Image(); sitemapOn.src="student/images4c1/sitemap_a.gif; 
sitemapOff = new Image* sitemapOff.src="student/images4c2/itemap.gif; 
sitemapBar = new Image(); sitemapBar.src="student/imagesaclisitemap_b.gif ; 

g_Loaded = 1; 

function rrisover(tabName) 

if(g_Loaded) 

imgOn = eval(tabName+"On.src"); 
documentimages[tabName].src=imgOn; 

imgBar = eval(tabName+"Bar.src"); 
document.imagesparlsrc=imgBar; 

function msout(tabName,curTabName) 

if(g_Loaded==1) 

if(tabName != curTabName) 

imgOff=eval(tabName+HOff.src"); 
documentimages[tabName].src=imgOff; 

if(curTabName != "") 

barOff="images/bar.gif; 
document.imagesrbarlsrc=barOff; 

} 

} 

/1—> 
</script> 

5.2.3 Perri 

There was already code in the perl scripts to load toolbar configurations 

from a file. This file is course-specific, so each course has its own 

configuration file that specifies which tabs will be enabled for the course. 

This was modified to save color scheme information - the two colors used 

in the toolbar. 
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The code to generate the toolbar is simple. The script generates HTML 

similar to the following: 

<IMG name="bar" SRC="stuclentiimagesacl/bargir BORDER="0" ALT="bargif"><BR> 

<A HREF = "home.html" onmouseover = "msover('home');" onmouseout = 
"msout('home',");"><IMG name = "home" SRC = "student/images/$c2/home.gif' 
BORDER = "0" ALT = "home.gif"></A> 

<A HREF = "grades.html" onmouseover = "msover('grades');" onmouseout = 
"msout('grades',");"><1MG name = "grades" SRC = "studentiimagesac2/grades.gir 
BORDER = "0" ALT = "grades.gif'></A> 
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5.3 Evaluating the Interface 

The interface was evaluated twice. The initial interface consisted of five color 

schemes. After evaluating this interface, it was changed to allow for 48 colors 

and evaluated again. Both evaluations consisted of two distinct groups of 

users — students and instructors. 

5.3.1 Consistency Inspection 

A consistency inspection of the new interface was carried out early in the 

evaluation process, when it was still possible to change small details. Details 

examined include: 

• Colors — Once a color scheme is selected, all pages for the course 

should reflect this decision. 

• Menus — The menu items will look similar to each other. Also, student 

and instructor menus will be similar to each other. 

• Layout — The menu will be at the top of each page. All that will change 

from page to page is the content shown in the lower portion of the 

page. 

5.3.2 Cognitive Walkthrough 

Several tasks were performed using the new interface. These include: 

• A student logs in and checks his/her grades. He/she then prints a list 

of homework assignments and logs off. 

25 



• An instructor logs in, adds a new assignment for a course, updates 

some grades, and adds online notes to study for an upcoming exam. 

• An instructor logs in and creates an online quiz. He/she updates the 

bulletin board to include information on the quiz and then emails the 

class to alert students. 

The interface was checked for efficiency (no excessive mouse clicks needed), 

and simplicity. A user did not have to traverse through deep menus in order 

to perform simple tasks. Also, it was easy to switch from task to task — the 

user did not have to click the "Back" button on his browser to return to a 

menu. 

5.3.3 Survey 

A survey was distributed among students in a "Webware" class [Cruz, 2000]. 

The students were asked to go to the ReCourse web page, log in, and use 

the system for a minute. They were then asked to fill out the survey based 

upon their impressions. The students evaluated the preliminary interface, not 

the final interface. The results from the 1 st  survey were used to develop a 

final interface. Another group of students was asked to evaluate the final 

interface by filling out the same survey. The survey can be found on the 

following page. Results can be found in Section 5. 
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ReCourse User Interface Survey 

To access ReCourse, go to  rittp:fipenguin.wpi.edu:4546.  Select Guest101 for the course. The 
user name is "guest" and the password is "guest". Spend a few minutes looking at the toolbar 
and moving the mouse over the tabs. 

Please fill out the following survey as accurately as possible. 

Background 
Occupation: 

Student 
Professor 

Previous Experiences with ReCourse 
	 None 

Used ReCourse in a Classroom Environment 
Worked with ReCourse as a project (IQP, MQP) 

Usability 
Please rate the following by circling the number that best reflects your response to the question. 

Agree Disagree 
1. The menu items are clear and easy to see. 1 2 3 4 5 
2. The colors do not distract from the purpose. 1 2 3 4 5 
3. The menu items are ordered in a satisfactory manner. 1 2 3 4 5 
4. The menu animations do not distract from the purpose. 1 2 3 4 5 
5. The menu animations improve accuracy in selecting tabs. 1 2 3 4 5 

Appearance 
Please rate the following by circling the number that best reflects your response to the question. 

Agree Disagree 
The colors used are pleasing. 1 2 3 4 5 
The toolbar design looks professional. 1 2 3 4 5 
The menu animation improves the overall appearance. 1 2 3 4 5 

Comments 
If you have any additional comments, please list them here. 

Thank You! 
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6 Results 

6.1 Preliminary Interface Survey 

12 students and 1 professor took part in the preliminary survey. The mean, 

median, and mode were calculated from the numerical answers for each of the 

questions. Note that 1=agree and 5=disagree. 

6.1.1 Usability 

Statement 	 Mean Median Mode 
1 The menu items are clear and easy to see. 	 1.83 
2 The colors do not distract from the purpose_ 	 175 
3 The menu items are ordered in a satisfactory manner. 	 2.42 
4 The menu animations do not distract from the purpose. 	 1.67 
5 The menu animations improve accuracy in selecting tabs. 1.75 

2 1 
2 1, 2 
2 2 
1 1 
2 1, 2 

6.1.2 Appearance 

Statement 
1 The colors used are pleasing. 
2 The toolbar design looks professional. 
3 The menu animation improves the overall appearance. 

Mean Median Mode 
2.67 3 2 
2.83 2 2 
2.25 2 2, 3 

6.1.3 Comments 

Few users left comments, but of those who did, the most common was that the 

colors could be improved. 

6.1.4 Overall 

This survey indicated that the toolbar design was solid but that the colors were 

not satisfactory. Better colors could also make the toolbar look more 

professional. This survey led to a redesign of the toolbar to add more colors and 

to allow the professor to select the two colors independently of each other. 
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6.2 Final Survey 

6.2.1 Usability 

Statement 
1 The menu items are clear and easy to see. 
2 The colors do not distract from the purpose. 
3 The menu items are ordered in a satisfactory manner. 
4 The menu animations do not distract from the purpose. 
5 The menu animations improve accuracy in selecting tabs. 

Mean Median Mode 
1.52 2 1 
1.7 2 1 
1.5 2 1, 2 
1.23 1 1 
1.64 2 1, 2 

6.2.2 Appearance 

Statement Mean Median Mode 
1 The colors used are pleasing. 1.1 1 1 
2 The toolbar design looks professional. 1.37 1 1 
3 The menu animation improves the overall appearance. 1.39 1 1 

6.2.3 Comments 

Again, few users left comments but all of the comments were positive. 

Several of the students surveyed had taken part in the preliminary survey 

and agreed that the new colors were a good decision. They allow much 

more flexibility. 

6.2.4 Overall 

This survey indicates that the shortcomings of the original design have been 

overcome. These shortcomings included poor colors and an unprofessional 

appearance. Allowing a greater number of colors made the toolbar look more 

professional, as it matched the web page's appearance. 
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7 Conclusion 

7.1 The Interface 

The interface developed and implemented as a result of this project is 

both more visually appealing and more effective than the original interface. 

The many colors available give professors significant freedom in page 

design. ReCourse comes with enough colors to match practically any web 

page. The ability to add more colors only increases this flexibility. 

Standard use of ReCourse does not require the user to understand the 

details of how the toolbar works. This is desirable since the toolbar was 

designed with all audiences in mind, not just the college audience that 

ReCourse was originally designed for. Another IQP that took place at the 

same time as this one was to add features to ReCourse that would make it 

suitable for use by high school students. Since the target audience is so 

large, it was decided to make the interface as simple to use as possible. 

7.2 Future Work 

A useful feature that could be added in the future would be a tool to easily create 

new tabs and colors. The appendices of this document explain how to do this 

manually, but it is a long process that could be sped up by automating it. Doing 

this would require complex image manipulation, which may be more suited to an 

MQP than an IQP. 
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8 Glossary 

Mean - Also known as the average, it is calculated by adding together all of the 

data elements in a set and dividing that by the number of elements in 

that set. 

Median - Calculated by sorting the data elements in the set. The median is the 

middle number in the set. If there is an even number of elements, the 

median is the average of the two middle numbers. 

Mode - The mode is the data element that occurs most often in the set. If two or 

more elements occur the same number of times, the set is multi-modal 

and therefore has 2 or more modes. 

Web-Safe color - A web-safe color is a color that appears the same on all web 

browsers and platforms. There are only 216 web-safe colors - other 

colors vary by platform. Using web-safe colors is less important now 

that it was several years ago. 
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Appendix A — Toolbars 

These are the toolbars that were developed as a result of this project. 

Instructor toolbar: 

Student toolbar:  

View Home Page 

Home Grades Bulletin Board Library Quiz Chat Class List Password      Search Site Map            

When the mouse is moved over any of the tabs, the color of the tab is changed to 

match the color of the top bar. The text on the top bar is also changed to match 

the highlighted tab. 

View Grades 

Home  Grades  Bulletin Board Library Quiz Chat Class List Password Search Site Map 

Color selection menu: (found on the instructor menu under "Toolbars") 

111  1111 	 1111  Ili 	 III  131 
II  III II  11  III  NI  III 
III  E 	 VI 
n [Li]  Ezi 
Lail Lir 

Color 1 (Toolbar):16 

Color 2 (Tabs):129 
Submit Changes 	 I 
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Appendix B - Adding Colors 

Although the ReCourse toolbar has been designed to include 40 colors, 

additional colors can be added in the future. This does not require any 

artistic skill, although familiarity with the image editing program "Paint 

Shop Pro 6.0" would help. Adding colors also requires editing a pert 

script; however all that is needed is a small change which is explained 

further in this document. It should be noted that the ReCourse toolbar is 

fully functional with the default 40 colors. 

IMAGE Creation 

1. Download and install "Paint Shop Pro 6.0". This program is shareware 

and can be downloaded from http://wwwjasc.com . 

2. Create a local temporary directory "temp" with 2 subdirectories "student" 

and "instructor". 

3. Copy files from "/users/ka19801/public_htmliwebrecourse/cgi-

biniinstructoriimagesipspitext color" to the instructor temp directory. 

4. Copy files from Vusers/ka19801/public_html/webrecourse/cgi-

binistudentiimagesipspitext color" to the student temp directory. 

5. Copy "colors.gir from "iusers/ka19801/public_html/webrecourse/cgi-

biniinstructori" to the temp directory. 

6. Open "colors.gif and edit the image to display your new colors and color 

numbers. Do NOT change the numbers of existing colors. Save the 

finished image. 



dor 

Normal 
Normal      

7. Open one of the PSP files. You may wish to zoom in on the image using 

the magnifying glass tool shown on the left. 

8. In the main menu, click "View->Toolbars". Be sure that the "Layer Palette" 

box is checked. Click "Close". 

9. The "Layer Palette" box should show 2 layers, "lines" and "color". The 

"lines" layer contains the border lines of each tab and any words that 

appear on the tab. The "color" layer is the tab color. 

10. Click the "color" label so that it is highlighted in blue. 

11.0n the right-hand side of the window, you can select a color for the new 

tabs. 

12. Select the flood-fill tool on the left-hand side of the window (shaped like a 

bucket). 

4o,  
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Batch ( onversion 

Look n: I _A  ___,I1JoJeffT.L1  
bar. gif 

j bar.psp 
bboard.gif 
bboard.psp 
bboard_b.gif 
bboard_b.psp 

cemail.gif 
cemail.psp 
cemail_b.gif 
cemail_b.psp 
chat.gif 
chat.psp 

N chat_b.gif 	 N gemail.gif 
,] chat_b.psp 	 N gemail.psp 

fileup.git 	 N gemail_b.c 
J fileup.psp 	 gemail_b.p 

] fileup_b.gif 	 N grades. gif 
N fileup_b.psp 	 N grades.psr 

I       tart File game: PsP     

Files of type: I All Files  Cancel    

Output settings 
Type: 
'CompuServe Graphics Interchange(".gif) 

Options... 

Output folder 

I C: \My Documents\IQP\toolbars\instructor\images\ -1 

Help 

Select AN 

r Stag on 
error 

Browse 

13. Click anywhere inside the tab in the current image. The tab color should 

change to the selected color. 

14. Repeat steps 7-13 for each PSP file in the temporary directories. 

15. Finally, convert the PSP files to GIF files. Click File->Batch Conversion. 

Locate the student temporary directory and select all the PSP files. Under 

"Output Settings", select "CompuServer Graphics Interface (*.gif)". Under 

"Output Folder", select the student temporary directory. 

16. Click the "Start" button. 

17. Repeat for the instructor temporary directory. 

18. Delete all PSP files in the temporary directory. 



ReCourse Configuration  

1. Create the directory /users/kal9801/public_html/webrecourse/cgi-

binfinstructorfimages/color on the ReCourse server, where color is the 

number of the color you are adding. Copy the instructor images created 

into this directory. 

2. Create the directory fusers/ka19801/public_html/webrecourse/cgi-

bin/student/images/color on the ReCourse server, where color is the 

number of the color you are adding. Copy the student images created into 

this directory. 

3. Copy the "colors.gif file to iusers/ka19801/public_htmlfwebrecourse/cgi-

bin/instructor/images/. 

4. IMPORTANT: Back up the iusersika19801/public_html/webrecourse/cgi-

biniinstructoristudent_toolbaricheck_toolbar.pl file!!! 

5. Open the check_toolbar.pl file and locate the line "# ENTER COLOR INFO 

HERE #". 

6. Change the next line to set $numcolors equal to the new number of colors 

available. 

7. Save the file. 

8. Test the new color by logging into a course as instructor. Click on 

"Toolbars", select the new color for one of the two colors, submit the 

changes, and reload the page. The new color should appear. 

Repeat these steps for each new color scheme to be added. 



Appendix C — Adding New Tabs 

Adding a Tab  

1. Download and install "Paint Shop Pro 6.0". This program is shareware 

and can be downloaded from http://www.jasc.com . 

2. Create a local temporary directory "temp" with 2 subdirectories "student" 

and "instructor". Under each subdirectory, create 2 more directories, 

"black" and "white". 

3. Copy files from "iusersika19801/public_htmlfwebrecourseicgi-

binfinstructoriimagesipspitext color" to the appropriate text color directory 

under the instructor directory. 

4. Copy files from "fusers/ka19801/public_htmlfwebrecourse/cgi-

bin/student/imagesipspitext color" to the appropriate text color directory 

under the student directory. 

5. Open one of the tab files that is the same size as the tab you want to add. 

6. Open the layer palette and select "lines". Erase the text on the image. 

Set the current color to black or white. 

7. Select the text tool and click inside the image. Set the font to "Arial", the 

size to 12, and select "Bold". Type the tab text into the box and click "OK". 

8. Center the text inside the image and click to place. In the menu bar, click 

"Selections->Select None". Save the image. 

9. Repeat this for each of the 2 color directories in both the student and 

instructor directories. 
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Resizing the Menu Bar 

1. Open the tab you just created and note the image width in pixels. This 

can be found by clicking "View->lmage Information", under "Dimensions". 

2. Open one of the bar images (ending in _b.psp). 

3. Click "Image->Canvas Size". Add the number you found in step 1 to the 

width. Be sure that the two checkboxes under "Image Placement" are not 

checked. Click "OK". 

4. Select the "color" layer in the image and flood fill the new area with the 

background color. 

5. Select the "lines" layer in the image and edit it so that the border line 

extends all the way to the new right edge. 

6. Save the image. 

7. Repeat for each bar in each of the 2 color directories in both the student 

and instructor directories. 

Coloring Tabs  

Now that the new tab has been created, it is necessary to save it in each of the 

40 colors. 

1. Follow the instructions in Appendix B to create images for each of the 40 

colors for both instructor and student. Note that only colors 1-9 have white 

text and 10-40 have black text. 

Editing the Code  

1. Open the file "/users/ka19801 /public html/webrecourse/cgi- 

bin/student/toolbar. p1". 
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2. Locate the code that generates the toolbar html. It begins with Javascript. 

3. Following the format for existing tabs, add variables for the new tab. 

4. Locate the html for the tabs you want to place the new tabs between. 

Again, following the format for the other tabs, insert code to display the 

new tab using the variables you declared in the JavaScript. Save the file. 

5. Open the file "/users/ka19801/public_html/webrecourseicgi-

bin/instructor/toolbar.pl". 

6. Repeat steps 2-4 for this file. 
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